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Arc Hydro: Tips and Tricks for 
Transitioning from ArcMap™ to 
ArcGIS® Pro 

Executive 
Summary 

This document provides tips and tricks for transitioning an Arc 
Hydro implementation from ArcMap™ to the ArcGIS® Pro 
environment. It focuses on elements that impact Arc Hydro. Most of 
these are standard ArcMap to ArcGIS Pro transition elements but 
are highlighted in the context of an Arc Hydro implementation. This 
document is not intended to be a comprehensive guide for an 
ArcMap to ArcGIS Pro migration. You should be familiar with Arc 
Hydro before continuing with this document. 
 
Additional resources include the following:  

 Arc Hydro: Project Development Best Practices—This technical paper captures 
what works well when implementing Arc Hydro projects both in ArcMap and 
ArcGIS Pro.  

• ArcGIS Pro has a default way in which it organizes data and project folders. 
This structure can be leveraged to support Arc Hydro best practices for data 
and folder organization (section 4.2 in Arc Hydro: Project Development Best 
Practices). 

 Arc Hydro: ArcGIS Pro Project Startup Best Practices—This technical paper 
discusses different ways to start an Arc Hydro project in ArcGIS Pro.  

 Switching to ArcGIS Pro from ArcMap—By Maribeth H. Price, Esri Press, 2019. 
This book transitions a user who is familiar with ArcMap into the mechanics of 
using ArcGIS Pro. Rather than teaching ArcGIS Pro from the start, this book 
focuses on how ArcGIS Pro is different from ArcMap. Covering the most common 
and important workflows required for GIS work, Switching to ArcGIS Pro from 
ArcMap leverages the user's prior experience to enable a more rapid adjustment 
to ArcGIS Pro. 

 

 

https://www.esri.com/en-us/landing-page/industry/water/2019/arc-hydro-best-practices
https://www.esri.com/en-us/landing-page/industry/water/2019/arc-hydro-arcgis-pro?
https://esripress.esri.com/display/index.cfm?fuseaction=display&websiteID=370&moduleID=0
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Key Arc Hydro 
Differences in 

ArcMap and 
ArcGIS Pro 

Conceptually, an Arc Hydro implementation is the same in ArcMap and in 
ArcGIS Pro. 

 The same approach to data and project development is taken. 

 The same workflows are used for data preprocessing. 

 The same database structures are established (except geometric network). 

 General functionality is the same. 

Most of the tools have the same functionality, with minor differences in look and 
feel to accommodate the two environments. Some differences do exist, and 
these are usually implemented in ArcGIS Pro to 

 Improve tool behavior in the context of a workflow. 

 Remove deprecated functionality. 

 Improve performance. 

At this point in the Arc Hydro development, both platforms are supported, and 
with few exceptions, new tools are developed and maintained in both.  

Key differences in Arc Hydro across the two platforms are related to the 
following: 

 Different management of layer and tool configuration 

 Use of Python and ArcPy™ software as the main development platforms in 
ArcGIS Pro vs. VB.NET and ArcObjects™ in ArcMap 

 Use of standard geoprocessing front end for tools in ArcGIS Pro vs. custom 
interfaces in ArcMap 

 Lack of geometric network support in ArcGIS Pro (replaced with new trace 
network functionality) 

If you are an existing Arc Hydro user in ArcMap, there is nothing significant that 
prevents you from transitioning to ArcGIS Pro, but you should carefully review 
your current Arc Hydro in ArcMap workflows and see if they are supported in 
ArcGIS Pro. If you see any missing functionality, please contact the Arc Hydro 
team via the Esri Water Resources GeoNet community. 

 

 

 

https://community.esri.com/t5/water-resources/ct-p/water-resources
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Task ArcMap ArcGIS Pro 

HydroID 
management 

Editor extension for 
HydroID management of 
new features 

Explicit management of 
HydroID for new features 

Layer 
management Via tags None—via default names 

Tracing Geometric network Trace network 

Toolbar ArcMap toolbar (extensive) ArcGIS Pro ribbon 
(minimal) 

Toolbox 
Mix of Python, 
ModelBuilder™, and .NET 
tools 

Mix of Python and 
ModelBuilder tools 

Tool 
configuration 

Extensive configuration 
capabilities through 
configuration XML and 
custom coding 

Minimal configuration 
using standard 
geoprocessing capabilities 

 

Table 1. Key Arc Hydro Differences in ArcMap and ArcGIS Pro 
 

HydroID management 
Arc Hydro in ArcGIS Pro does not have an editor extension that will automatically 
populate HydroID for newly digitized features. Instead, add all new features (either 
with regular editing or appending/importing data into feature classes) and then run 
Assign HydroID from Arc Hydro Tools Pro -> Attribute Tools -> ID Management. Use 
the Overwrite HydroID option to control overwriting of any existing HydroIDs in the 
target feature class. 
 
Layer management 
Arc Hydro in ArcGIS Pro does not have the concept of a tag, so there is no internal 
knowledge of which layers should be default inputs into Arc Hydro functions. Most of 
the Arc Hydro ArcGIS Pro tools have an input default name defined for a layer, so if 
your Table of Contents contains a feature class of that name, it will be selected as 
the default input. There is no special Arc Hydro code that manages that. It is a 
standard geoprocessing tool capability and can be modified by the user if needed. 
 
Toolbar 

Only a few functions that take interactively defined x,y locations from the map as 
input (user's click on the map) are present in the Arc Hydro ribbon in ArcGIS Pro. All 
other functions are accessible through Arc Hydro Pro Toolbox. 

 
Toolbox 

Most Arc Hydro ArcGIS Pro functions are implemented in Python and exposed as a 
script in the Arc Hydro toolbox/toolset. There are few functions implemented in 
ModelBuilder. The organization of the toolbox in ArcGIS Pro matches the 
organization in ArcMap, with minimal changes. 
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Tool configuration 

There is no custom Arc Hydro tool configuration in ArcGIS Pro. All tool configuration 
is done using standard geoprocessing tool configuration capabilities and can be 
modified by the user if needed. 

 
Starting an Arc 

Hydro Project in 
ArcGIS Pro 

By now, you should have read the Arc Hydro document Arc Hydro: ArcGIS Pro 
Project Startup Best Practices. That document captures different ways to start an 
Arc Hydro project in ArcGIS Pro. In this section, we will focus on how to start an 
Arc Hydro project in ArcGIS Pro when data and .mxd files from an Arc Hydro 
project in ArcMap exist and are to be used. This is covered in section 2.4 of the 
Arc Hydro: ArcGIS Pro Project Startup Best Practices document. It is presented 
here but uses a different dataset as an example. This dataset will be referenced 
later in this document. 
 
Leveraging an existing Arc Hydro dataset and MXD project 

This approach intends to maintain the same folder and naming structure developed 
in ArcMap. A typical Arc Hydro data structure might look like the one below. In the 
example, the AMGN folder contains the Layers folder with all the rasters, the 
HUC18070203.gdb with vector and tabular Arc Hydro data, and HUC18070203.mxd 
ArcMap project. 

 

The goal is to use the same main folder (AMGN) to maintain the ArcGIS Pro project 
using the existing geodatabase as the default project geodatabase and Layers folder 
for storing rasters. The name of the ArcGIS Pro project will match the name of the 
geodatabase (HUC18070203.aprx). While this was the recommended project 
structure in ArcMap, it is not as critical in ArcGIS Pro but is still a good practice and 
helps with the ArcMap to ArcGIS Pro transition (for consistency). 

1. Start ArcGIS Pro and select the new Map template. 

2. Specify the name of the new project and the folder in which to create it. Keep 
the Create a new folder for this project check box unchecked. Note that the 
specified project name can be anything EXCEPT the name of the existing 
geodatabase in the target folder. In this case, we are naming the project 
MyProject and placing it in the 
C:\CurrWork\ArcHydro\Tests\ProNetwork\AMGN folder. 

https://www.esri.com/en-us/landing-page/industry/water/2019/arc-hydro-arcgis-pro?
https://www.esri.com/en-us/landing-page/industry/water/2019/arc-hydro-arcgis-pro?
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3. Click Insert –> Import Map (main ArcGIS Pro tab). 

4. Navigate to the existing ArcMap .mxd file you need to import (in this case 
C:\CurrWork\ArcHydro\Tests\ProNetwork\AMGN \HUC18070203.mxd) and 
click OK. 

 

5. Click Project –> Save As (from the main ArcGIS Pro tab). 

6. Specify the name of the new project and the folder in which to create it. The 
specified project name should match the name of the geodatabase in the 
folder where the project will be saved. In this case, we are naming the project 
HUC18070203 and placing it in the 
C:\CurrWork\ArcHydro\Tests\ProNetwork\AMGN folder. 

7. Create a new toolbox called HUC18070203.tbx in the project folder (via 
Catalog). 

8. ArcGIS Pro Catalog should look like this: 
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9. Click Project –> Options -> Current Settings (from the main ArcGIS Pro tab). 

a. In Default geodatabase and Default toolbox, select 
HUC18070203.gdb and HUC18070203.tbx respectively. The 
form should look like this: 

 

b. Click OK to apply changes. 



 
Arc Hydro: Tips and Tricks for Transitioning from ArcMap to ArcGIS Pro 

 
 

 
 

 
 
 

JANUARY 2021 10 

10. Click Save to save the project. 

11. Use the Catalog view to inspect changes. 

12. Delete all references to MyProject (e.g., tbx, gdb, and .aprx files—some 
might have to be deleted from the file manager). 

13. The final folder structure should look like this: 

 

14. An optional step is to remove the .mxd file. It is not recommended to use 
both ArcMap and ArcGIS Pro versions of the same Arc Hydro project.  
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Tracing One of the key differences (from the Arc Hydro viewpoint) in the geodatabase 
and analytical support between ArcMap and ArcGIS Pro is the management of 
networks and tracing. ArcGIS Pro does not support geometric networks that were 
the foundation of the Arc Hydro data model and some of the Arc Hydro analytical 
tools. 

ArcGIS Pro 2.6 introduces trace networks. Trace network in ArcGIS Pro provides 
geometric network capabilities that the Arc Hydro data model and tools used in 
ArcMap. While there is no one-to-one equivalency, trace network allows similar 
capabilities, and as it evolves with future releases of ArcGIS Pro, additional 
functionality will be available that was not possible with geometric networks. 

For an overview of trace networks, please read "Introducing the Trace Network 
with ArcGIS Pro 2.6." 

This section presents a quick review on how to mobilize trace network in the 
context of typical Arc Hydro workflows.  

A geometric network developed in ArcMap will be used as a starting point to 
demonstrate the differences between the two networks. Trace network can also 
be built within ArcGIS Pro from basic feature classes, which will be 
demonstrated. 

Converting geometric network to trace network 
The initial geometric network used in the example was built using NHD data (using 
NHDPlusHR packaged NHD data). The NHDFlowline feature class residing in the 
Hydrography feature dataset was used to build a geometric network called 
NHDFlowline_Net. It has the following properties:  

 

 

https://www.esri.com/arcgis-blog/products/arcgis-pro/data-management/introducing-the-trace-network-with-arcgis-pro-2-6/
https://www.esri.com/arcgis-blog/products/arcgis-pro/data-management/introducing-the-trace-network-with-arcgis-pro-2-6/
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This network is part of the HUC18070203.gdb geodatabase discussed earlier 
(Starting an Arc Hydro project in ArcGIS Pro).  

Note that geometric networks can be seen in a geodatabase via the ArcGIS Pro 
interface but are not supported. Also, note that the following operation will delete the 
geometric network from the geodatabase, so make sure you make a backup of the 
geodatabase in case you need it since trace network is not supported in ArcMap. 

1. From ArcGIS Pro, use the Trace Network Tools toolbox (available in ArcGIS 
Pro 2.6 and above) and run Convert Geometric Network To Trace Network. 
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a. Navigate to the HUC18070203.gdb\Layers feature dataset and 
select NHDFlowline_Net in the Input Geometric Network field. 
Type "NHDFlowline_TN" in the Output Trace Network Name 
field. 

 

b. Run the tool. 

2. Review the geodatabase in Catalog (you might have to refresh the view). 

3. The geometric network is deleted, and the trace network is created. 

4. Right-click on the NHDFlowline_TN trace network and select Properties. 
Review the network properties. 

a. What are participating feature classes and of what type? 

b. Is network topology enabled, and how many features participate 
in the network? 

c. How many "dirty" areas are there? 

d. What are the network attributes? 
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5. Before a trace network can be used, its topology needs to be enabled. Run 
Enable Network Topology and select NHDFlowline_TN in the Input Trace 
Network field. 

6. Review network properties again. 

a. Is network topology enabled, and how many features participate 
in the network? 

b. How many dirty areas are there? 

7. Add the network to the map. 

8. Review all the layers added to the map when the network was added. 

a. What do dirty areas represent? 

b. Can you identify the problems? 

c. Review point errors. 

d. Review line errors. 

9. Run Validate Network Topology and select NHDFlowline_TN in the Input 
Trace Network field. Make sure you validate the full extent of the network. 

10. Review network properties again. 

a. Is network topology enabled, and how many features participate 
in the network? 

b. How many dirty areas are there? 

11. Ideally, you will "clean" all the dirty areas. As you are making edits, run 
Validate Network Topology to see if your edits have fixed the issues. This 
function can operate on the local extent only so you can do quick checks on 
a subset of the data (where the edits have been made). 

12. In the Trace Network ribbon, run Display Flow Direction. 

a. Zoom in and inspect the direction arrows. Do they make sense? 
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Fundamentals of 
Tracing through 
Trace Networks 

This section describes basic tracing capabilities in trace networks. Make sure that 
the trace network is established, enabled, and validated. 

1. In the Trace Network ribbon, click Trace Locations > Starting Points. 

a. A Trace Locations pane will open. 

i. Click on an edge where you would like to start a trace 
(select something on a main river, close to the 
downstream end of the system). 

2. Once the point is placed, in the Trace Network ribbon, run Upstream. 
Accept defaults for the geoprocessing tool and run it. 

3. Review the results (selected set of features). 

a. If the trace failed, why did it fail? Have you cleaned all the 
errors and validated the network topology after the edits? 

b. If there are still errors in the network, uncheck Validate 
Consistency on the trace tool's form and run the tool again. 

i. This allows tracing through errors. 

4. Clear selection in the map and clear Starting Points from the Trace 
Locations pane (click on the red x next to the displayed feature). 

5. Identify location upstream of flow splits (look for lines with DivergenceFlag 
= 1). 

6. Add a network start point upstream from a divergence. 

7. Trace downstream. Note that multiple paths are selected at divergences. 
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8. To be able to use a value from a field to control tracing, it needs to be set 
as a network attribute. 

a. Run Disable Network Topology on NHDFlowline_TN. 

b. Run Add Network Attribute and create an attribute name 
called Divergence of short type and allow it to be nullable. 

c. Run Set Network Attribute and set network attribute 
Divergence to be from field DivergenceFlag from NHDFlowline 
feature class. 

d. Run Enable Network Topology on NHDFlowline_TN. 

9. Rerun the trace downstream tool. 

a. Uncheck Include Barrier Features. 

b. Under Advanced Options, fill in the Condition Barriers section. 
Use Divergence = 1 as the conditional barrier. 

 

10. Notice that now only a single downstream trace path is defined. 
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11. Network attributes allow you to constrain the trace. In the following 
example, we will limit the downstream trace to 10 km. Notice that 
NHDFlowline has the field "LengthKM" that can be used to constrain the 
trace. If such a field did not exist, it could be easily created and calculated 
using standard geometry calculation capabilities. Follow this procedure to 
set up the trace network for trace containment using length in kilometers: 

a. Disable network topology. 

b. Add network attribute LenKM (double, allow null). 

c. Set network attribute LenKM to be from field LengthKM from 
NHDFlowline feature class. 

d. Enable network topology. 

12. Rerun the trace downstream tool. 

a. Uncheck Include Barrier Features. 

b. Under Advanced Options, fill in the Condition Barriers section. 
Use Divergence = 1 as the conditional barrier. 

c. Under Advanced Options, fill in the Function Barriers section. 
Use LenKM => 10 as the functional barrier. Note that the 
operator Is greater than or equal to is used since this is the 
condition to place the barrier (so we limit the overall distance 
to less than 10 km). 
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13. The result shows the length limited main stem downstream trace. 
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Building the Trace 
Network from the 

Ground Up 

If a geometric network did not exist in the geodatabase as input for trace network 
creation, a trace network can be built from the ground up. We will use the same 
feature class and attributes as in the Tracing section earlier in this document. 
First, we will delete the existing trace network (NHDFlowline_TN) since a feature 
class can participate only in one network (do it from Catalog). If necessary, 
remove all trace network artifacts from the map. The network will consist of only 
the NHDFlowline feature class, and we will use DivergenceFlag and LengthKM 
fields as network attributes. The following functions are all run from the Trace 
Network Tools toolset: 

1. Create Trace Network (NHDFlowline_TNManual). 

 

2. Add Network Attribute (Divergence). 

 

3.  Add Network Attribute (LenKM). 
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4. Set Network Attribute (Divergence). 

 

5. Add Network Attribute (LenKM). 

 

6. Enable Network Topology. 
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7. Inspect the network in Catalog. 

a. Is topology enabled? 

b. How many features participate in the network and from what 
feature classes? 

c. Are network attributes properly configured? 

8. Inspect the network in Contents. 

a. Point and line errors 

b. Dirty areas 

c. Flow direction 

9. Are there any differences from the network created by geometric network 
conversion in the previous Tracing exercise (pg.11)? 

10. Perform traces starting from page 16.  

a. Are there any differences in behavior and results? 

11. What other feature classes and attributes might be useful in network 
analyses. 

Note that with proper design and planning of the network (specially its 
attributes), its creation can be straightforward and linear. 
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Creating a 
Network Diagram 

Trace networks enable the building of network diagrams. Be aware of the 
following rules: 

1. Diagrams are built from selected features in the network. 

2. They cannot be built over dirty areas. 

As an example, we will build a diagram from a trace result. 

1. Select a point on the network and trace upstream. Make sure that the 
trace does not go over any dirty areas. 

 

2. On the Trace Network ribbon, click New under the Diagram section and 
select Basic. 

 

3. A new network diagram is created. 

4. On the Network Diagram ribbon, click Store to store the diagram (give it 
a name, e.g., Trace Result 1). 
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5. On the Network Diagram ribbon, click Diagram Layouts and select Smart 
Tree. 

a. Accept the defaults for the geoprocessing tool and run it. 

b. The figure below shows the diagram with system junctions 
turned off for better visibility. 
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6. Review the diagram. 

a. Does it help with understanding the system morphology 
better than the geographic representation? 

b. Zoom in to see the detail. 

7. Experiment with other types of diagram layouts. 

8. Explore other capabilities of network diagrams. 

 
Trace Network 
Observations 

Regarding 
Geometric 
Networks 

To build, edit, and use trace network, you need standard or advanced licensing 
of ArcGIS Pro. All vertices in a line feature participating in a trace network are 
important, not just those vertices where edges and junctions participating in the 
network connect. This makes the "cleanliness" of the features more important in 
trace networks than it was for the geometric networks. Topology that was clean 
in the geometric network might not be clean in the trace network. 

Trace networks have distinct management of topology (errors and dirty areas). 

 
When building a trace network, do the following: 

a. Create a trace network. 

b. Optionally add and set network attributes. 

c. Enable the network. 
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d. After making edits, validate the network. 

You can ignore the errors in the trace network and perform tracing through errors, but 
the results might be incorrect. 

By default, flow direction in edges will be set to digitized direction once the network 
topology has been enabled and validated. 

Not all types of traces that were available in the geometric networks are available in 
trace networks. 

Trace networks support richer tracing options than geometric networks (for those 
traces that are supported). 

Trace networks support the generation of network diagrams. 
 

ArcGIS Pro 
Implementation 

Tips 

This section presents a diverse collection of ArcGIS Pro workflows that are often 
used with Arc Hydro in ArcMap and can be confusing for first time ArcGIS Pro 
users.  
 
Add Arc Hydro toolbox to the project toolboxes 

After Arc Hydro tools are installed, both the Arc Hydro ribbon and toolbox (Arc Hydro 
Tools Pro) are available for use in ArcGIS Pro. The toolbox is accessible like any 
other toolbox in ArcGIS Pro, primarily via the Geoprocessing -> Toolboxes pane. If 
you want to add Arc Hydro toolbox to your project toolboxes, follow this procedure: 

1. Go to the Catalog pane. 

2. Right-click Toolboxes and select Add Toolbox. 

3. Navigate to the location where the Arc Hydro toolbox has been installed 
(typically C:\Program Files\ArcGIS\Pro\Resources\ArcToolBox\Toolboxes) 
and select Arc_Hydro_Tools_Pro.tbx. 

 

4. Click OK to add the toolbox to your collection of project toolboxes. 
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Once the Arc Hydro toolbox is in your project, you have full access to Arc Hydro 
tools for copying and editing (you cannot copy Arc Hydro tools directly from the 
Geoprocessing pane). 

Editing Arc Hydro tools 

Depending on your system privileges and how you started ArcGIS Pro, you might not 
be able to edit Arc Hydro tools directly in their native location (you need to be a 
system administrator to be able to do that). It is also not recommended to edit the 
tools directly but rather make a copy of them. To create a copy of an Arc Hydro tool, 
follow this procedure: 

1. Add Arc Hydro toolbox to your project set of tools (see pg.26).  

2. Navigate to and right-click the Arc Hydro tool you are interested in, then click 
Copy. 

3. Navigate to the toolbox you want to place the tool in (e.g., your default 
project toolbox or any other toolbox you have edit privileges for), right-click 
on it, and select Paste. 

a. This will create a copy of the selected tool.  

4. Right-click on the tool and select Properties. 

a. Notice that the source code for the tool is still pointing to the 
original source code for the Arc Hydro tool. 

5.  Right-click on the tool and select "Edit". 

a. In the text editor, click Save As and place the tool in the directory 
where you have write privileges. Note the location of the target 
directory. It is recommended that you change the name of the 
Python file to avoid any possible confusion on which version of 
the tool is being run (e.g., add your initials at the end of the file 
name). 

6. Close the text editor. 

7. Right-click on the tool and select Properties. 

a. Under General, change the location of Script File to point to the 
location and name where you saved the copy of the code (step 
5a).  

b. It is recommended that you change the name of the tool to avoid 
any possible confusion on which version of the tool is being run 
(e.g., add your initials at the end of the tool name). 
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You have now created a copy of the Arc Hydro tool that you can edit any way you 
want without impacting the original tool. 

Geoprocessing and other options 

The Options pane is accessible through Project -> Options in the main ArcGIS Pro 
ribbon. The following are options of interest: 

1. Current Settings 

a. Location of default geodatabase and toolbox. 

2. Map and Scene 

a. Add layer 

i. Make newly added layers visible by default. Uncheck the 
check box if processing large datasets in batch operations. 

3. Geoprocessing 

a. Allow geoprocessing tools to overwrite existing datasets. Check 
the check box. 

b. Add output datasets to an open map. Check the check box. 

c. Script editor—Point to your favorite script editor. 

d. Write geoprocessing operations to the XML log file. Check the 
check box if you are interested in reviewing the operations 
outside the ArcGIS Pro environment. 

4. Display 
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a. Local cache—Note potentially large cache being stored. It might 
be worth clearing it from time to time. 

5. User Interface (for all elements) 

a. Position of the first view opened in the project—You can control 
whether to place the window in the active map or separately. 

6. Customize the Ribbon—Add commands to existing ribbon elements. 

7. Quick Access Toolbar—Add commands to Quick Access Toolbar. 

Required vs. optional inputs 

In ArcMap, optional inputs for a geoprocessing tool would be identified as such on 
the geoprocessing form after the parameter name. 

 

 

In ArcGIS Pro, you have to highlight the information about the parameter to see if the 
parameter is optional (hover over the "i" next to the parameter name). 
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Layer and feature class properties 

In general, layer or feature class Properties in ArcGIS Pro work similarly in ArcMap. A 
notable difference is that to view an attribute list, you access it through Design -> 
Fields and not through Properties (when right-clicking on the layer [Contents] or 
feature class [Catalog]). 

1. To set up a display field to be used for feature pop-up (identify), go to Layer 
Properties -> Display -> Display field. 

2. To configure feature pop-up (identify), right-click on the layer in the Contents 
pane and select Configure Pop-ups. Very detailed configuration is possible. 

Creating a hillshade/shaded relief 

Creating a hillshade was one of the first operations when dealing with terrain 
processing in Arc Hydro in ArcMap. The easiest way was to use Image Analysis 
(under Windows in the main ArcMap interface) is to select the digital elevation model 
(DEM) in the list of rasters, and then click on the Shaded Relief icon. This would 
generate a temporary raster. 

In ArcGIS Pro, the process is slightly different. First, if you are using a default 
basemap, it will include the World Topographic Map and World Hillshade. The World 
Hillshade might be good enough for quick visualization of the topography, and the 
development of explicit hillshade might not be needed. 

If you need to create a hillshade (often if your DEM is more detailed than the one 
used for the World Hillshade, or if you have hydro-conditioned the DEM and want to 
see the impact), there are several ways of doing it. 

The article "Create Amazing Hillshade Effects Quickly and Easily in ArcGIS Pro" 
presents one of the ways to do it. 

The following steps follow the same pattern as the article (using a raster function 
instead of a geoprocessing function that creates a new raster) but generate a shaded 
relief instead of a hillshade. 

https://www.esri.com/about/newsroom/arcwatch/create-amazing-hillshade-effects-quickly-and-easily-in-arcgis-pro/
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1. Open the Raster Functions pane from Analysis on the main ArcGIS Pro 
ribbon. 

2. Scroll to the bottom and expand the Surface functions and select the Shaded 
Relief option. 

3. Set Raster to your DEM dataset. 

4. Set Hillshade Type to Traditional or Multidirectional, as desired. 

5. Set Scaling to None if you are making a map at a single map scale (such as 
a printed map), or select Adjusted if you are making a multiscale map (such 
as a web map). 

6. Set Z Factor to a higher number to exaggerate the height variation in the 
terrain, or use it to convert the elevation units to the x,y linear units if they 
happen to be different. In this example, the factor is set to 0.01 since the 
vertical units of the DEM are in centimeters. 

7. Click the Create new layer button at the bottom of the Raster Functions pane 
to create a new layer in the current map. Note that this creates a new display 
of the processed data—it is not a new raster dataset. 

ArcGIS Pro for developers 

While these tips are not directly Arc Hydro related, we find them useful when 
developing Arc Hydro projects.  

Log file—It is useful to write geoprocessing operations to the XML log file (see 
pg.28) that will allow you to review the full report for each geoprocessing function. 
Note that the logs are stored in the 
%APPDATA%\ESRI\ArcGISPro\ArcToolbox\History directory. Also, these logs are 
verbose, and while not large, they can accumulate quite quickly, so it is 
recommended that during normal operations, this option is checked off. 

Copy path—Getting a full path to a layer is often used when executing operations 
from a Python command line. 

1. Click on the data element (feature class/table/raster/…) of interest in the 
Catalog pane. 

a. Note it must be the Catalog not Content pane. 

2. Under Map in the main ArcGIS Pro ribbon, click Copy Path. This will place 
the full path to the data element onto the clipboard. 
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Notebooks—Jupyter notebooks are fully integrated into ArcGIS Pro 2.6 and 
higher. The article ArcGIS Notebooks in ArcGIS Pro (2.6) presents an overview 
of working with notebooks in ArcGIS Pro 2.6.  

Jupyter notebooks can be very useful when developing and documenting new 
workflows. 

Raster cell iterator—Raster cell iterator (RCI) allows you to access individual 
cells in a raster. RCI has been available since ArcGIS Pro 2.5. The article 
"Introducing the Raster Cell Iterator" presents an overview of working with RCI. 

 

 

https://community.esri.com/docs/DOC-15279-arcgis-notebooks-in-arcgis-pro-26
https://community.esri.com/community/gis/analysis/spatial-analyst/blog/2020/02/06/introducing-the-raster-cell-iterator


 

 

 
 
 
 
 

For more information, visit 
esri.com/WaterResources. 
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